
Field Guide to Quick Deployment Thermocouples
This guide is intended to outline all of the steps & associated details
necessary to:  1) Launch your data logger, 2) Trigger the logger, 3)
Place the thermocouple in the field, and 4) To stop the logger and
save the data after the burn. Be sure to read the complete manual
1) Prepping the Data Logger for use:

Launching the  logger should  be done the day of the  use,  before the  logger is  paired with the
unless  a  laptop  is  used  to  launch  them  in the field.

prior to thermocouple use.

housing  unit and  brought to the  field

Open  Hobo-ware

Connect data  logger to  USB  port.

In  the  lower  left  hand  corner,  you  should  see ``  Dev:  HOBO  ...Thermocouple JKST ,... "

Under the Device drop-down select Launch.  Select 01(.

Make sure battery  level  is  not too  low.

In Channels to Log-Make sure only  box  1  is checked.   This will  save battery  life.   Only check box  2  if interested
in  what temperatures the logger itself is experiencing.

In  Logging  Interval-  Make sure  it is set to  1  sec.

In  Launch Options-  Make sure Trigger is selected.  (this allow you to start the thermocouple  in the field  by

pressing  a  button)

Hit Launch.  Light on  logger should  now be blinking every 8 seconds or so.

2) Trigger the Logger (how to start logging temperature)

Triggering the data  logger will  be conducted  prior to  conducting  your burns.  (note:  from  starting the  loggers,  you  have approxi-
mately 8  hours of logging)

Remove the  logger from  the housing  unit and  hold the black  button for at least 3  seconds.

You  should  see that the red  light is blinking  more  rapidly,  once every second.

Connect the  logger to the thermocouple and  close housing  unit.

Deploy logger in  burn  area according to experimental  design  and  ensure the  housing  unit will  not  melt (bury  or
cover with  wet towels).

3) Thermocouple Placement (how to install this in the field)

After you  have triggered the logger in the field,  assure the  red  light is  blinking,  and  then  begin to place the  unit on the desired  site

Lay the wrapped  case  in the desired  location  underneath the vegetation,  attempting to leave the area  relatively
undisturbed

Part vegetation and  lay thermocouple wire,  as close to  bare ground  as  possible.

Using  landscaping  pins,  stake down the wire to the ground,  to secure  it from  moving.

Roughly  2  inches from the tip of the  wire,  pin the wire down  so the tip  is elevated  from the surface of the ground
approximately  lcm.

Restore vegetation  to  previous  condition  (fluffing  if necessary,  similar to ``leave  no trace'')

Record  the position of each data  logger on a  map of the area  by the number on  each  of the data    loggers

4) Stop the Logger and Save Lagged Data

After you  are done with the  burns,  removed the thermocouple  units and  return them  to the office or lab for data  retrieval

Open  Hobo-ware and  connect logger as  instructed  above.

Under Device drop-down,  select Stop.  Hit OK-Yes.

Under Device drop-down,  select Status.  Look over battery level  and  memory  used.  Select OK.

Under Device drop-down,  select  Readout.  OK.  Label  hobo file  and  place  in  appropriate folder.  If you  want to see the
data:  When  plot  setup  window  appears,  hit  Plot.

Note:  To ensure logger data  is not lost,  save the  logged  data every time the  logger is stopped.   When The logger js  re-launched,
the data  will  be erased.



Fully  Set-up  Quick  Deployment Thermocouple

Thermocouple  wire  pinned  to the  ground

Thermocouple  wire  pinned  to  the  ground,  with
vegetation  parted.

)r.  Amy  Ganguli

Red  light  blinking  circled  in  green.  Black  trigger

button  circled  in  red.

Thermocouple  wire  pinned  down  to  the  ground.  Red
line  signifies  2  cm  gap  between  ground  and  tip.

Thermocouple  unit fully  set  up,  vegetation  re-
stored  and  ready to  burn!



HOBOwar® for PC and Mac, V®i.lan 3.2.1

Last updated June 30. 2011

Weleome to HOB0ware     This version of HOBOware is available to customers of Onset Computer
Corporalionundertheterm§oftheSotwareLicenseAgreementconfairiedintheinsfallationprograms
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ln8tallallon ol HOBOwar® 8otwar®:

PC Users. Please doubletliek "HOBOware_Setup.exe.'.    When the installer comes up, follow the
instruclton§IfyoudonothaveasupportedversionofJava(1.6_22orlater)installed,tlleinstallerwiw
insfalHt for you     HOBOware will infomi you ifyour Java version  is nol up to date     Please see the note
below regarding llie latesl version of Java.

MacUser§.TheprcoedurewHIvarydependingonwhelheryouareworkingfromaproduclCDora
downloaded installer file     lt using a CD,  please doubleellek .'HOBOware pkg'' and follow the instructlons.
If you have downloaded the installer.  please doubleilick the file  named    H0Bctware_lnslaMer.ding, then
doubletlick the HOBOware.pkg file     you must have a supported version of Java (16 or laler) already
installed. Java SE 61.6 0_22 is available for oS X 10.5 in Mac oS X vl0 5 Update 9  Java SE 6  t6 0  24
is availal)le for OS X 10 6 jn Mac OS X vl0.6 Update 4.

IJ.log the HOBOware updat®r:

PC Useis:  Plea§e doubletlick .'HOBctware_Updater exe'..    Wlien the installer comes up. follow the
instructions     You must have HOBOware currently installed for the updaler to suceed     Please see the
note below regarding the latesl version of Java.

Mac users:  Please double-click "HOB0vyare_Updater ding file,  then doubleclick the
HOBOware_Updaler.pkg file and fowow the instructions.    you  must have H0BOware currently insfalled
for the Updater to succeed.

Before doubletlicking the updater file please make sure that HOBOware has been Shut down

Pl®a8® No'®:

Sample dafafiles are contained in the installer and updater, and are also on the CD.    On tlte PC, these
filesarealsoinstalledinthecommondocumentsareaat\DcoumentsandSettingsIAHUsers\Shared
Documenls\HOBOwarePubli.cFiles\SampleDafafilesforWindowsXPand
\Users\Publie\Dcouments\HOBOwarePubljcFiles\SampleDatafilesonWindowsVistaandWindows7.
OntheMac,lhesenlesareinsfalledintheuser'sLibrary/ApplicalionSupport/HOBonrefolder.

TheJavaRunllmeEnvironment(JRE)forWindows,availablefromoracleAmerica,Inc,isalso§uPPIIed
on the HOBOware product CD,  in the Java-JRE folder.

System Requlrements:

HOBO\rare 32.1  has sorrie baslc common system Requirements that are presented in the list below.      If
using  HOBOware as the data collection server for a network of Indoor Vvireless HOBO data nodes you
may \rant to consider the configuration guidelines pro\/ided in the table.    There are riiore detailed
conflguTation recommendatlons available on the Onset Vveb site at
htoM^ww.onsetcomD,com/suDi)oat/kno\^rledaebase/hoboware-30-Performance

• PC: Vvindows 7 (Pro.  Ultimate and Home Premium), Vvindows XP Pro, Windo\ms XP Home. Vista

Busmess, Vista Home Premium

• Mac:  OS X Versions  10.5.x and  10.6.x.

• Java Runtime En\/ironment (JRE) 1.6 (32-bit or 64-bit on windows)       please note that version  1.6,  also

known as Java 6, is officially supported on OS X only on  lntel Core 2 Duo and later processors.    See the
time zone note below

• One Of the follo\i/ing  lntemet browsers (\/ersion number listed is the hiehest maior version we tested).

Safari 4 or greater,  Flrefox 3 or greater, Mierosoft Internet Explorer 8.0.

• Minimum screen resolution Of 1024x768

• 256+ cokms

• Processor Speed, Memory and Disk Space

High  End
CPU                     2.9 GHz

dual core
RAM                    3 GB
Disk space     256 + (see note)
UserModel     4

Mid  Range
2.0 GHz
dual core
2GB
256 + (see note)
3

Low End
1.a GHz
single core
1.5  GB
256 + (see note)
2

Lowest End
1.8 GHz
single core
lGB
300 MB
1

The User Model row suggests some guidelines for uslng the Processor Speed and Memory table:

User Model 1    - Using  HOBO Data loggers only,  ro data nodes -traditional desktop user
User Model 2    - Using  HOBO Data loggers and up to 5 data nodes, 20 sensors
User Model 3 -Using HOBO Data loggers and up to 50 data nodes,100 sensors
User Model 4 -Using HOBO Data loggers and up to  100 data nodes, 200 sensors

Disk space -Defining the disk space requirements for LIOBOware depends on the proposed use.      The
fa]ble above describes the disk space needed for a traditional desktop user,  allowing for installation Of the
program and storage Of data files.    For users Of HOBO data nodes. the space requirements depend on a
variety Of factors,  including the number Of nodes, the number Of sensors. the frequeney Of data sampling,
the longevity Of depleyments, and other factors.    Please see the FAQ on the Onset Web site for more
details,  at httD://\^Mn^/ onsetcomD com/suDDart/knowledaebase

• Alarm & Readout Tool Additional Requirements:
• Continuous Internet connedion and access to SMTP service to send notifications
* One or rrrore Of the following:

- Email account (to receive email notiflcafrons andfor readout data)
-Alphanumerlc pager (to receive text message notifications)
-Text-message enabled cell phone (to recei\/e te)ct message notifications)
- FTP account (to store readout data to an FTP location)

NorroE



HOBOwaTe3.21lsbu.lltwithJava1.60_25onWindousarldonOSX.WhileHOBOwaremayrunus|ng
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HOBOwaTe321onMacisbuiltfo.OSX105asaminimlJmWhMeHOBOwaremayrunusinga
previousversionofOSX,eahierversionsofOSXare§peciflcallynolongersupported.
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New Features aidded in HOBOware 3.2.1
•TheintegrationoftheAlarmandReadoutTool,Whichisnowautomaticallyin§talledaridavaHablefor

use from the Tools menu (HOBOware Pro only).

• HOBctware 3 2.1  is an English-only release

•Arevi§iontothecalculationfortheS-SMDSonMoisturesensorensuringdataisdisplayingaccurate|y

•reqTu,r:daE;":s,:a',,a#33n6:daTJ,,:tarapt:rn:suenrsmtaopr:,re::£:,:ti::s:na#il::dusn:#:I:sf:;::!Lrv#esare

• compatibilfty W.Ith iMac, MacBook Pro and  lntel Core i5 and i7 processors

;oThHeooBpgo3::cle£,:sn:;,:,:ioodso,:art:,:uet:,it:nt:cao,TyFmv;:fL?rel::snnuosineg:!evE:I:Pn::voethrye'rca'ure
applications,suchasMierosoftExcel(HOBOwareProonly).

• Macintosh Support for (he U24 series loggers

• Several other high priority bLig fixes

Known lesLi®s:
•ioggerslaunchedinHOBOware32.0cannotbereadoutinearlierversionsofHOBO\mare.

•TheBulkExportToolprelerencetoincludeYAMlheadersCurrentlydoesnolresultinYAMLheaders

beingcreatedThiswillbeaddressedinafuturereleaseofHOBOware.

•whenrunningonanon-EngllshdesktopthereistheremotePossibilitytlllatyoumayencountera

:'s:::etTeb:I:_g*:3,u,:i:etoL:uant?:nwJnhda°swbeeTnh£ELaesct:%efno:Oat,nt:::e3:=C%nsfl'CtT'::e'te:r:°u#d'::ew::nb,em
S#::dn}:;aenngce°:hn:e+,i:'eF:S:g:t:°2P4'.:I:uinces.andundertheDISplaycategory,mtheDateIT|me

•FromtheExportPrefeTencespane,ifselectingtlieoption.nlncludesensorserialnum|)er,or

iabe|ifavailable..inordertoexporttllelabelstring.youmiistalsoselecttheoption,u|nc|ude
sensorlabet(if available)inPointstableanddetailspane,.inthePlottingPreferencespane

•whenrunninginaFrenchlocalePleasebeawarettllatthekeyboardacceleratorkeyshavenotbeen
•      _-I.--Han.tntha French lanauaae     Forexample, the keytoselectthecrosshairtoolwhen

:ioattn,#st°card#?etshseoirtehnec,haiagnugaugaeg:fth:a:seex|
int:rface.  Plc-ase see the application Help for details

on these accelerator keys.

* I( has been reported that the NOD32 virLis detection program from ESET com reports an embedded

Win32/Adware. LastDefender spyware application in the HOBO\^/arepro_Updater.exe program.    This has
been reviewed with  ESET and has been  identified as a false positive.    To our knowledge. after scanning
the installer and updater programs prior to releasing them. tliere is no spyware or matware embedded  in
our installers or llpdaters

• When launching a HOBO Pendant with only events enabled (no temp,  no battery logging).  HOBOware

correctly sets the logging  interval to one hour (so the battery doesn't drain),  but I.ncorrectly sets the
intemal information used by shuttles to re-launch the logger to a one-second interval, This is OK for the
initial launch,  but if the logger is re-laiunched with either the  U-DT-1  or U-DTW-1  shuttle it Starts "lagging"
at one second, draining the battery.     It isn.I lagging data since it isn.t supposed to,  but it does wake up
once a second, causing the battery to drain faster than expected.

• The new icon(s) may not show up  immediately after installation.     Generally this will rix  itself af[er a

reboot.

• Plots with series that lagged over the Spring or Fall time change will not dl.splay the time change

• Occasionally HOBOware may report that communications with the logger failed -just retry the operation.

• While in a locale which formats numbers as follows "123 456 789,00'', when entering a number in an

input field. do not use the spacebar to inplJt the grouping separator. The grouping separator is a no-break
space character,  and the spacebar will insert a space character, which the inpiit rield will treat as an
invalid character   lt is best to enter the number without any grouping separator(s) and when you  leave the
input field.  the value will format itself correctly.

• When a serial logger (HOBO Weather Station.  HOBO Micro Station,  HOBO Energy Logger) is awaitlng

an interval, delayed, or button start,  the sensor readings are not updated in the Status wiridow  This I's a
hardware limitation.  When  logging  begins.  sensor readings will  update as usual

• At low screen resolutions (1024x768), plots with many series (and therefore many Y axes).  may initially

display too small     A message "Plot panel Too small" will display across the plot when this occurs     To
see the plot,  try maximizing  HOBOware to fiill screen size.     If this does not work.  try  hiding  the details
pane and  points table`

• Changing the units of a series  using  the rightelick menu  item "Convert Series Units" will work for

everything except the Y-axis values used by that series.  Use the Main Menu  item "Edit I Convert Units" or
the Toolbar button ''Convert units for all series"  instead.

• The HOBO U14 can be launched without the Temperature channel or the Rela[ive Humidity channel

selected, although there will be a waning about this condition   The  logger will continue to display current
conditions of those channels,  but no data will be logged and alarms will not work.

• Ttie battery state for the HOBO U23 loggers (-001. -002,  -003 and -004 versions) is shown as Good at

I)attery voltages above 2.85 V. The battery state should be shown as Good only when tlie voltage reads
3.1  V or higher.

• Users of the HOBO Energy Logger (H22-001 ) may find that they are warned. "The battery voltage on

this logger is too low to use excitation power " This waming is sometimes given even when the battery
voltage is high enough to supply excitation power  We suggest that you make your own decision  based
on the voltage reading from the Sfatiis window or from the battery gauge near the top of the Launch
window

That dialog.s waming should not be confused with the dialog whose text,  "This logger's battery is
very  low.„" is only issued when the  logger battery is dangerously  low  You should  NOT ignore this
dialog's warning



• The Bulk Export Tool preferences may not show up in the Preferences window under some

circumsfances,    Closing the Preferences window and reopening usually corrects the problem.

Wlndow8 0rlly:
• lf you are receiving a User Access Control warning every time you start H0BOware 3.2.1,  be sure that

you are not running  H0BO`^/are in Compatibility mode.  To cheek this,  right-click the  HOBO\^rare desktop
shortcii[, go to the Compatibility tab and  Lincheck the Compatibility options particularly that for "Run as
administrator'.

* HOBOware does not support roaming user profiles

• By default,  HOBOware maps all .hobo and .dff files to itself.    This will remove (he mapping from

GreenLine or Boxcar Software.     If you would like to remap the file types to the original software,  use the
Map/Unmap biittons in tlie General pane of HOBOware Preferences. To use the Map/Unmap feature
yoii'll need to run HOBO\rare with administrator privileges. otheiwise you get a series of ''error modifying
registry" messages.  Even while running as administrator, occasionally tlie Map/Unmap biittons in
Preferences may produce an error message.    Simply click the button again and the mapping should
proceed properly

• lf the logger you  plug  in has never been seen by yoiJr computer before, the Foiind New Hardware

balloon will appear next to the Windows Taskbar and any default action on  plug will  not work.     If you wait
until the system informs you the device is ready and unplug (he logger and plug it back in, the default
action on  plug will then  happen.

I When exporting points to Excel,  it is possible that the resultant Excel file may not open in the exac(

same forma( when opened in Excel on a Macintosh system.

• When exporting details to text,  it is possible that the resiiltanl text file may not open in the exact same

format when opened in a text editor on a Macintosh system.

* As described  in the manual,  bitmap images of the graph can be pasted directly into many applications,

However, the following steps are needed to paste the graph into a Wordpad document:
From the Insert menu, choose Object`
In the Insert Object dialog,  click the Create New button.
Chcose Bfroap Image from (he list.  Click OK.  This should create a frame in your document.
From the Edit menu, choose Paste. The graph should appear within the frame

Wlnl]owe V[eta Only:
• While at the time of this writing there are both 32 and 64 bit Vista-compatible Keyspan drivers available

from Keyspan's wet]site for the Keyspan  USB-to€erial USA-19HS, there are no Vlstacompatible
Keyspan drivers available for the older USA-19QW adapter. The Keyspan Serial Assistant won`t
recognize the device,  nor does Vista.    Please ensure that if you need to use a Keyspan  USB-to€erial
adapter you are using the USA-19HS device.

* AI the time of this writing there is Vistaiompatible device management software for Tibbo devices. but

with limitations. This includes the Virtual Serial Port Manager, Connection Wizard and Device Server
Manager.     please see the Tibbo web site for details (\^^^/`^/.tibbo.com)

Mac Only:

• The onoinal version ol the Pendant Base Station has a known issue that results in slower

communications with versions of HOBO\rare for Mac.    This will not affect the validity of the data.
Pendant Base Stations with serial numbers below #961469 have this problem.    The serial number is
visible through the clear plastic of the Base Station on a while label.     Please check periodically for an
update to H0BOware that addresses this issue, or contact Onset Computer Corporatlon Technical
Support (w\^/w.onsetcomp.com) for a free replacement Pendant Base Station.

• AI times. it is possible that the HOBOware menu enters a disabled state, where the items in the menu

are disabled.  If you restart HOBOware, the menu will return to its normal state.  Be sure to save any
unsaved data before restarting  HOBctware.

• When exporting points to  Excel,  it is possible that the resultant Excel file may not open  in the exact

same format wheri opened in  Excel on a Windows system.

• When exporting details to text,  it is possible that the resultanl text file may not open in the exact same

format when opened in a text editor on a Windowrs system.

• HOBOware for Mac may experience problems when using a Keyspan  USB to Serial Adapter that is

attached to a USB hub.     It is recommended that Keyspan  USB to Serial adapters be attached directly to
the USB port on the computer to avoid this issue.

• On OS X vl0.5 (Leopard), the Apple Help icons found in some HOBOware dialogs may not work if yoLir

default web Browser (Safari or Firefox) is not already open      ln some cases this may callse HOBOware
to crash.  If you experience this problem please update to the latest version of OS X.

Alarm and R®adotlt Tool:

• Support for UX120 and other upcomlng logg®rs. Alarm and  ReadoLJt Tool currently supports all

U-Series and serial logger types as were supported in  HOBOware 3.1.  Support for the new UX120
loggers and any other loggers supporfed after HOBO\^rare 3.1  will be addressed in a future Alarm and
Readout Tool update

• Slipport for u30 loggers.    Althotigh Alarm and Readout Tool will support U30 loggers,  please be

aware that the USB port on  U30's will time out ater thirty minutes of inactivity.     This means that Alarm
and Readout Tool must poll the U30 at an interval of less than thirty minutes or the U30 will be come
unreachable un(il the  USB connection  is unplugged  and  re-plugged.

• Important note on scheduled roadoi)I of event and state data. To do scheduled readouts of event or

state loggers such as a U9 or a Ull  with  partial readouts, the battery channel must be logged to get valid
timestamps. The battery lagging interval can be as large as you \Arant,  up to the maximum -the only
reqLiirement is that the channel be enabled.

• Alarm sensor conditions cannot be Set on event or state channels.  For example, with U9 and U 11

loggers, only the logger conditions (e.g. communication,  memory, and  battery level) can be monitored.

• If you communicate with a logger in HOBOware Pro while there is a monitor running on it,  the  monitor

will report Communication  Failure and/or Readout Failure as long as HOBOware Pro is accessing the
logger (i.e. accesslng means Launch,  Status,  Readout. or Stop window is open).  Once HOBOware  Pro is
finished with the logger the monitor will clear the Communicat'Ion  Failure and resume running as
expected.

• lf a logger is being read by the monitor while you attempt to list available devices in HOBOware Pro,  the

logger being read may not appear in the list or you may get a conimunication error.  It is best to wait until
tlie monitor is not performing a reading,  to list devices.

• Data Assistants and  Filtered series preset from the Launch winciow cannot be used with the Alarm and

Readout Tool.  They will cause the Alarm and Readoll( Tool to rea I the data incorrectly.

• When importing text files created by scheduled readouts into HOBOware Pro,  it is possible that not all

Data Assistants will function properly.  For example,  if you attempt to use the Linear Scaling Assistant you
may only get a (itle bar when clicking Process,  leaving you  unable to linearly scale any cllannels.  If using
Data Assistants is important to you,  it is suggested that you enarile the datafile format as well as the text
file forma( when setting up scheduled readouts. Triis way you wi.I be assured access to the Data
Assistants when opening the datafile.

* When reading out files to text file format. data is al\^rays in Sl.  I.he HOBOware Preference for US/Sl

units is not followed.



• Loggers launched with multiple intervals cannot be schediiled for parfual readouts.

• lf you set up scheduled partial readouts on a serial logger that is `nrrap{nabled, and the logger wraps

before the first partial  readout then that readout will fail and the monitor will no longer attempt to read out
the logger.

* If you set up scheduled partjal readouts on a sei.ial logger that is wrap-enabled, and the logger wraps

more than once between readouts (hen data has been lost and there will be a gap in the data
timestamps.  Therefore that readout will fail and  the  monitor will no longer attempt to read  out the logger.

I When performing scheduled readouts to text f"e format on a logger that was launched with alarm

parameters (such as the UA-001  Pendant Temp/Alarm), these alarm parameters are not stored in the text
file. When  you  import tlle text file into HOBOware  Pro,  there will no( be alarm lines drawn on  the graph.  If
you would like to have alarm lines displayed on the graph when opening tlie readoiit file,  be sure to save
to the datafile fomat.

* When importing an qemptyn text file created  by scheduled readouts into HOBOware Pro,  it is possil]le

that you will get an  invalid plot.  An .empt`r text file is a file with just an  End of File event.  It is possible to

get an .empty" text file if you are performing readouts on a logger that is on a delayed or triggered start

• When  performing alarm checks on a logger whose memory is almost full, if you have enabled the logger

memory alarm condition to be tripped when the loggerJs memory is at N% or above, you may receive an
errant < Memory 0% CLEAR > alarm notification  in addmon to the expected < Memory M %> alarm
notification,  where M  is greater than or equal to N.

I For Mac users,  the Launch  Program notification method sometimes fails when passing in a file

argument.  Be sure to check that your Launch  Program notification method settings are functioning before
leaving a monitor unattended.

• If you  have the  Host Computer notification  method enabled  in addition to anotlier notification method.

such as Email or Text Message to Mobile Device,  if this other notification method fails due to incorrect
SMTP settings,  lack of internet connection, or some other reason. then you will not be able to view the
lasl notification  in the  Details window even though  Host Computer is also enabled

• When a serial logger (HOBO Weather Station.  HOBO Micro Station,  HOBO  Energy Logger) is awaitirlg

an interval, delayed, or button start, the sensor readings are not updated.  This is a hardware limitation.
This means that alarm conditions are being checl(ed against readings that are not cLirrent and may result
in FALSE or MISSED alarm conditions  When logging begins, sensor readings will be updated at the
logging  interval,

• lf you (or an automated program) set your syslem time clcok back in time after the monitor has started.

the monitor will  not begin  responding again  until yoii  reach the time al which  you turned your clock back.
For example,  if at 2:00:00 PM  your system clock  is set back to  1 :56:00  PM.  the monitor will  not take
readings again unlll the system clock reaches 2:00.00 PM.  If you must adjust the system clock.  it is best
[o slop the monitor,  make yoLir adjustments, and then start the monitor again.  (This is not an issue when
the system clock is automatically set back or forward to accommodate a knowri shift for Dayllght Savings
Time.)

* Optic loggers:

- U20,  U22,  and TidbiT loggers in couplers go to sleep after 30 minijtes to conserve battery

power` They won'( wake up unless you take them ou( of the coupler and then reattach ttiem.  If one of
these loggers is added to a configuration, the interval needs to be less than 30 minutes to prevent the
logger from going to sleep   Please note that keeping the logger continually awake will result in an
increased  battery drain.

- UA loggers do not go to sleep, but their batteries run down faster when in the coupler. even
when the logger isn't communicating.

• Starting with HOBOware version 2.7, the Alarm and  Readoiit Tool stores its conrigurations and readouts

in a new location on Macintosh compL.ters.  If you had a previous version of HOBOware or a previous

version of Alarm and Readout Tool,  these were stored  in a Documents/HOB0ware folder in silbfolders
named Alarms and Readouts.  Now these folders are in tlie Library/Application Support/HOBOware folder
off your Home folder. You can con figure the Alarm and Readout Tcol to change the location of where it
stores the readouts and where is stores the alarm configurations,  but it will continue to save its
configurations in the old  location unless you reset your Preferences. You can do this by changing the
folder in the "Save as...'. dialog or you can go to the  Preferences dialog and choose "Restore Defaults".
You will then need to change any of the preferences you may have changed before

Questions or comments?    Please direct to Onset Computer Corporation at
1-800-LOGGERS (1-8oo-5644377) or suDDort@onsetcomD com


